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Constant-current
tED navigation lights

This constant-current LED circuit
has been used as the basis for a 24-
LED navigation light on a yacht. The
LEDs were arranged in two staggered
rows around a 32mm plastic pipe
placed in a small glass jar. For a
24-LED array, eight of these current
sources will be required.

The LED drive circuit works as

follows. The LM334 constant current
source maintains
a nominal 64mV
between its "R"
and "V-" terminals
and it does this by
adjusting the base
current of transis-
tor Q1 so that the
collector current
is 19.39mlt. Atthis
cufient, the volt-
age across the 3.3Q

resistor is maintained at 64mV a¡d
so the three series-connected LEDs
are operated at a constant 19.4m4.

Four of these drive circuits were

each built onto two circular pieces
of Veroboard which were then
stacked inside the glass )an'|he 24
LEDs were then wired to the drive
circuits.

The accompanying photos show
how the assembly is wired and
housed in the jar, The plastic lid
needs to be painted with several
coats of white acrylic to prevent
deterioration due to [fV exposure.

]osh Stevenson,
Kotare, NZ.

Replacement

lor small petrol motors
If the CDI module in your motorbike, outboard, ride-on mower
or other small petrol motor fails, you could be in for a shock.
Depending on the brand or model, they can cost up to $+OO. You
can build this one for less than $50 and it will do the same iob
for most engines.

R'.i?:å:#tTåå'ii."'i"lU;
module for motorbikes, outboards a¡d
other small petrol motors, You can
understand why. It can be a real shock
to front up to your local dealer and
find out the price for such a module.
It is even ha¡der to justify the prices
charged when you see the circuit
components involved,

Those days, a great many small pet-
rol engines use a Capacitor Discharge
Ignition (CDI) module. The high-volt-
age capacitor is charged directly from
a generator located on the flywheel,
A battery may still be included and
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used to drive lights and ancillaries
but this is used independently of the
ignition.

CDI is a great improvement on the
old magneto ignition systems, Not
only does the CDI deliver higher spark
energy but it also dispenses with the
points which were inevitably subject
to wear and required periodic clean-
ing, adjustment and replacement.

The one drawback is that CDI sys-
tems don't last forever - they can fail.
While the failure can be within the
flywheel generating coils or the igni-
tion coil, it is most likely to be the
CDI module itself and then you will

find that the replacement can be very
expensive.

The CDI Module described here
maybe used to replace a failed factory
unit for an engine that incorporates a
generator and trigger coil to provide
the high-voltage and the firing point.
Most of these CDI systems operate in
a similar way but there are variations
in design that use the opposite polarity
for voltage generation and are therefore
unsuitable for our module.

While some tests can be performed
to check for suitability, we cannot
guarantee that the module will work
for every engine, Even so, because this
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Optical smoke
detector

This smoke detector circuit is
based on a standard photo-inter-
rupter as used in many computer
printers. It contains an infrared
LED facing a phototransistor across
an air gap.

br this circuit, the collector of tìe
phototransistor (PS1) is connected
to +1.2Y via a 2,2kC) resistor and
trimpot VR1. The collector also

d¡ives the non-inverting input (pin
3) of op amp IC1 which functions
as a comparator.

Normally, tìe output from the
infrared LED shines across the gap
and turns on the phototransistor
which pulls pin 3 of IC1 low As a
result, the comparator's output at
pin 1 will be low and transistor Q1
will be off.

If enough smoke passes through
the gap, the infrared LED's output
will be blocked and pin 3 of IC1 will

8C548

SOUNDER

go high and so Q1 will be turned on.
This will uigger amonostable timer
based on 555 timer IC2 and this will
sound the piezo bttzzer for a time
determined by the 100kO resistor
and 100pF capacitor at pins 6 & 7.
Tïimpot VR1 is used as a sensitiv-
ity control.

A suitable photo-intemrpter can
be obtained from faycar (Cat. ZD-
1e01,).

T. K, Ha¡eendran,
Kerala,India. ($35)
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CDI Module uses cheap and readily
available parts, it may be worth a try
if you are unwilling to fork out lots of
ha¡d cash for a genuine replacement
module.

How CDI works
Fig.1 shows the connections re-

quired for a typical CDI module. The
generator (magneto) coil provides the
high voltage to charge a capacitor (in
the CDI module), while the trigger
coil provides the signal to dump the
capacitor's highvoltage charge into the
ignition coil. A kill switch shunts the
high-voltage supply from the generator
to prevent ignition.

Fig,2 shows how CDI works, It
comprises three main components:
the ignition coil, a capacitor (C1) and a
Silicon Controlled Rectifrer (SCR). The
SCRbehaves as a switch, It is normally
a high impedance until a small trigger
voltage is appliedbetween its gate and
cathode. It then conducts and behaves
like a diode. After triggering, the SCR
switches off when the current through
it falls cìose to zero,

Initially, the SCR is off and capaci-
tor C1 is discharged. Positive voltage
from the generator then charges C1 via
diode DL and the primary winding of
the ignition coil. The current path is
shown in red as "Iç".

C1 is discharged when the SCR
is subsequently triggered, allowing
current to flow back through the igni-
tion coil primary. This current path
is shown in green as "I¡". The fast
discharge of C1 and resulting current
through the ignition coil causes a high
voltage to be developed across the
secondary winding of the ignition coil,
to fire the spark plug(s).

Once the spark plug is extinguished,
the collapsing field of the ignition
coil develops a reverse current flow
via diode D2 to partially recharge
capacitor C1.

Typically, the generator coil delivers
about 1A in charging the capacitor up
to about 350V. If C1 is 1pF, then it will
charge in about 350ps - much quicker
than the time between sparks, even in
a high-rewing engine,

No RPM advance
Note that the CDI Module does not

incorporate RPM advance and so it
provides a fixed timing from the trig-
ger coil - most common with small
engines,

Some engines do incorporate RPM

siliconchip.com.au

TYPICÆ MODUIE FOR CDI WITH ÐCTERNAL CONNECTIONS SHOWN

Fig.L: how a typical CDI mo generator (magneto)

coil provides ltrign voltage n the CDI module, while
the tiigger coil próvides the the capacitor's high
voltage charge into the ignition coil.
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advance using a special trigger coil and
magnetic core design that advances
the firing edge with increasing RPM,
This is achieved by having a stepped
or shaped coil core that has a larger
gap at its leading edge compared to
the trailing edge - see Fig.3.

At low speeds the coil voltage re-
quired for triggering is developed at
the trailing edge of the magnet but as

revs increase, the leading edge of the
magnet is able to induce more voltage
in the coil and so firing occurs earlier.
This is shown in Fig.4,

Other designs use electronic ad-
va¡rce but these require extra power for
the circuitry and tend to be used only
with battery-powered systems.

Circuit details
The simplest circuit arrangement

for the CDI module is shown in Fig,5,

Voltage from the generator coil charges
capacitor C1 (and C2) via diode D1
and the ignition coil primary. As
previously mentioned, D2 is there to
conduct the reverse current flow from
the ignition coil after the capacitor has
discharged.

The two in-series 1MQ resistors
across capacitor C1 are there to dis-
charge the capacitor if the SCR does
not fire, This is a safety feature that
prevents a nasty electric shock if you
happen to connect yourself across the
capacitor. It takes about two seconds
for the capacitor to discharge to a safe
value.

Provision has been made on the
PC board for two discharge capaci-
tors, C1 & C2, This allows the use of
either two O.47¡tF capacitors or two
1pF capacitors. A higher capacitance
will produce greater spark energy,

IFRONT PANET OF
PIUG PACK CASEI
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Frequency indicator for generating equipment
This circuit was developed to

adjust the operating speed (RPM)
of portable AC generators. These
usually have a speed-control knob
but no means of determining the
correct (50H2) frequency, Since this
sort of job is done outdoors, a dig-
ital frequency counter is not really
justified and canbe difEcultto read,
because of the typically long gating
time at low frequencies.

Two NAND gates, IClc & IC1b, are
wired as a 500H2 oscillator a¡d this
clocks a4O77 decade counter, IC2.
This drives L0 LEDs but only one
will be on at any particular time,
as the counter cycles through from
1-10. However, all the LEDs are

connected to 0V via a common lkCl
resistor artd tralsistor Q1 which is
turned on and off by a 50Hz signal
derived from the generator,

If the 50Hz and 500H2 frequen-
cies are precisely locked, the dis-
play will show a stationary LED.
However, if the 50Hz signal is
slightly high in frequenc¡ the LED
will appear to move in one direc-
tion and if the signal is slightly low
the LED will appear to move in the
opposite direction.

The 50Hz ?4OVAC input from
the generator is fed via tra¡sformer
T1 and it powers tle circuit via
rectifier diode D1, a 100pF filter
capacitor and a 7809 9V 3-terminal

regulator (REGI). The 50Hz signal
from the transformer is also fed via
a 10k^O resistor to a squaring circuit
comprising gates ICld & IC1c. This
drives transistor Q1.

In use, the u¡it is plugged into
the mains outlet of the portable
generator and the governor speed
of the engine is,adjusted to give a
stationary LED display, For 60Hz
equipment, the oscillator would be
set to 600H2.

Note thatthe oscillator frequency
should be adjusted precisely with
the aid of an accurate frequency
meter.

Dayle Edwards,
Taylorville, Westland, NZ. ($60)
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ADVANCE TRIGGER HEAD DESIGN

Fig.3: some engines achieve RPM advance using a special trigger coil with
a stepped magnetic core that has a larger gap at its leading edge compared
to the trailing edge. This advances the firing edge with increasing RPM.

¡ 50ms

reverse voltage on the gate while the
5LC) resistor limits the gate current to a
safe value. A 1kO resistor ties the gate
to ground to prevent false triggering,
while the 10OnF capacitor filters noise
and transients that may cause the SCR
to trigger at the wrong time.

A kiII switch connection has also
been provided to shunt the generator
cuuent to ground and stop the mo-
tor,

Circuit refinements
The simple circuit of Fig,5 works

well but additional circuitry can im-
prove reliability and provide for more
consistent triggering. The extended
circuit is shown in Fig.6.

First, diode D4 has been added
across the generator and thus shunts
negative excursions across the coil
to less than -0,7V, Without D4, the
anode of diode D1 can be subject to
-350V from the negative swings of the
generator. This means that diode D1
could have over 700V across it if the
capacitor is charged to +350V.

While D1 is rated at 1000V D4
reduces the maximum likely voltage
across it to around 350V or so and
thereby reduces the possibility of re-
verse breakdown ofthe diode.

Triggering in this version of the
circuit has also been improved in two
ways. First, we have added a series
1OpF capacitor to the gate ofthe SCR.
This capacitor prevents false trig-
gering due to any DC offset from the
trigger coil that may be more positive
than it should be because of remnant
magnetism in the coil's core, The LkÇ)
resistor across the capacitor is there
to discharge the capacitor and is high
enough in value to prevent it triggering
the SCR on its own. Diode D5 prevents
the 1OpF capacitor from being charged
with reverse polarity when the trigger
coil output swings negative.

A second improvement involves the
use of a negative temperature coeffi-
cient (NTC) thermistor across the gate
of the SCR. This thermistor reduces its
resista¡rce with increasing temperature
and is used to compensate for the
lowered triggering requirement of the
SCR (for both voltage and current) at
higher temperatures.

Effectively, the NTC thermistor
forms a voltage divider with the 51C)

resistor, At 25'C, the thermistor is
500Q and so it attenuates the signal
from the trigger coil to 91%, However,
at L00'C, the NTC thermistor resist-

Device
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Ext = use an external programming header or the adaptor board. operating system, timing problems
could arise. For this reason, it is pru-

at http://freenet-homepage,de/dl+yhf/ Because WinPIC tries to switch the dent to use the "slow mode" option in
winpic/winpic_faq,htm as a first resort programming lines in real time and the "Interface " tab if you suspect there
if you are experiencing problems, because Windows is a multi-tasking may be timing problems. Sc

(FLYWHEETI
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N MAGNET 
S

AT HIGHER RPM

Fig.4: the effect of a stepped trigger core design is shown in these timing
advance waveforms, At low speeds, the coil voltage required for triggering
is developed only at the trailing edge of the magnet (waveform A).
However, at higher revs, the leading edge of the magnet induce a greater
voltage into the coil and so firing occurs earlier (waveform B),

provided the generator coil can charge sary signal to trigger the SCR. When
the capacitors to the full voltage in the the coil voltage goes positive, it feeds
required time. current to the gate of the SCR via a 51Q

The trigger coil provides the neces- resistor and diode D3. D3 prevents
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Fig.4: clicking the Interface tab in WinPic brings up this
window. Ensure "COMB4 prograrnmer for serial port" is
selected for the Interface Tlpe and be sure to choose the
correct COM port.

Fig,5: after selecting the device to be programmed (see

text) go to the Options tab and select the options shown
here. The dsPIC or PIC can then be programmed as
outlined in step 4.

Once the programmer has been
initialised correctly by WinPlC, you are
ready to program some PlCs. Here's the
procedure, step-by-step:
(1) Check that the power is off, then
insert the PIC or dsPlC you wish to pro-
gram into its corresponding ZIF socket
(according to Table 4).
(2) Setthe jumpers as indicated inTable
4. Note that either JP1 or JP2 (but NOT
both) must be installed for dsPlCs. Simi-
larly, either JP3 or JP4 (but NOT both)
must be installed for PIC microcontrol-
lers, as set out in the table.

lf these jumpers are incorrect, pro-
gramming will almost certainly fail.
(3) Once the jumpers have been set,
apply power, start WinPlC, go to De-
vice -> Select and select the PIC or

dsPlO you wish to program from the
drop down menu. That done, go to the
"Options" tab and select the opt¡ons as
shown in Fig.5.
(4)To program the dsPlC or PlC, go to
File -> Load -> Program Device and
select the hex file to be programmed.
Note that the fuse bits should be within
the hex file and they will be programmed
as well.

WinPlC should now start to program
your device and then verify its contents.
You can use the "Code" tab to see the
program memory.

lf programming is successful, you

should see the message "Program-
ming finished, no errors" at the bottom
lefthand corner of the window.

You can also erase, read and verify a

microcontroller using WinPlC, although
you should keep in mind that reading a
code protected device will result in zero
readings forthe program memory bytes.
For more detailed information on how to
use WinPlC, refer to its help menu.

Finally, note that WinPlC accesses
the serial port on your PC and requires
real-time control of the programming
signals. lt is therefore poss¡ble that it
will lock up while programming is in
progress and fail to respond to mouse
or keyboard commands.

To prevent this, avoid having other
Windows programs running in the back-
ground while WinPlC is programming a
device. lf the WinPlC window stops re-
sponding when programming a device,
simply wait for it to finish.
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ance is around 35O and the trigger
signal is divided down to 41% of the
trigger coil value,

This attenuation in signal level at-
tempts to match the SCR's reduced
trigger level requirement at higher
temperature. So as temperature rises,
the signal is increasingly attenuated
and as a consequence, the SCR fires
at the same trigger coil voltage over a
wide tempetature range. Without the
thermistor, the SCR would be subject
to timing changes with temperature.

Construction
A small PC board coded 05105081

and measuring 64 x 45mm caters for

Fig.5: this is the circuit for the Basic Version. The kill switch is there to
stop the motor by shunting the generator coil's output to ground, while the
1kQ resistor on SCRl's gate prevents false triggering due to noise.

both versions of the circuit. This can
fit into a plastic box that measures
70 x 50 x 20mm and this box allows
the whole module to be subsequently
potted.

Begin by checking the PC board for
the correct hole sizes. The four corner
mounting holes should be drilled to
3mm, as should the hole for the SCR
mounting tab. That done, checkthe PC
board for breaks in the copper tracks
or for shorts between tracks. Make any
repairs before assembly.

Fig.7 shows the simple version of
the circuit, while Fig.B shows the
more complex version. The choice is
yours but we recommend the version

tGNtftoN
cott

If everything is working correctly,
you should see the message "Initial-
ising PlC-Programmer: Success" at
the bottom of the WinPIC window, as

shown in Fig.5.

Troubleshooting
If you receive the message "WARN-

ING: Could not initialize program-
mer!" instead, you can test the inter-
face manually to narrow down the
Iist of possible problems. Here's what
to do:
(L) Clicking the "Vpp(+13V)" box
should toggle pin 1 of CON3 (the exter-
nal programming header) from 0V þox
un-ticked) to around +12,5-13V þox
ticked), If this doesn't happen, check

70 Stuco¡rt Cutp

that transistors Q1 & Q2 are the cor-
rect types, Ifthey are, trâce the signal
from pin 3 of the serial port to pin 1 of
CON3, checking at each stage that the
signal toggles as this box is "ticked"
and "un-ticked" in WinPIC,
(2) Clicking on the "Clock" box should
toggle pin 2 of CON3 from 0V [un-
ticked) to around +4-5V (ticked).

If that doesn't happen, check the
}i4AI'232 and its surrounding capaci-
tors, That done, check the signal at pin
7 of the serial port, then at pins 13 &
L2 ofICL,pin 1 of IC2, pin 2 of IC2 and
finally pin 2 of CON3,

Note that the MAX232 (IC1) should
level translate the signal level at pin
13 to about +5V at pin 1'2.

(3) Clicking on the "Data (to PIC)" box
should toggle pin 6 of CON3 from 0V
to around +3,5-5V and you should see

the "Data In=" fleld change from 0 to
1. The latter should be 0 with the box
un-ticked and 1 otherwise.

If this is not the case, check the
signal at various points on the circuit
from pin 4 of the serial port to pin 6

of CON3, Check also that pin B of the
serial port is receiving the correct level
(read by WinPIC and displayed in the
"Data In=" field),

Read the FAQ
Finally, if the programmer is still

not working, there could be issues
with WinPIC. Refer to the online FAQ
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Fig.6: the Extra Features Version includes diode D4 to shunt negative excu¡sions across the generator.coil to less
thãn -0.2V and thus limit the voltage across D1 to around 350V. It also features an improved bigger circuit, to ensure
consistent firing of the SCR with variations in temperature.
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G

DI
I N5408

Farts Est

1 PC board, code 05105081, 64
x 45mm

1 potting box, 70 x 50 x 20mm
(Jaycar H8-5204 or equ¡valent)

1 500Cl NTC thermistor (Jaycar
RN-3434)

1 M3 x 10mm screw
1 M3 nut

Semiconductorc
1 C1228,8T151 500V SCR

(scR1)
3 1N5408 3A 1000V diodes

(D1,D2,D4)
1 1N4004 1A 400V diode (D3

for Basic Version; D5 for Extra
Features Version)

Capacitors
1 1O¡rF 25V PC electrolYtic
1 l¡tF 275VAC or 280VAC

metallised polypropylene; or
20.47¡tF 275VAC or 280VAC

metallised polypropylene; or
21¡tF 275YAC or 280VAC

metallised polyProPYlene

- see text
1 100nF MKT polyester
1 1OnF MKT polyester

Resistors (0.25W 1%)
21MO 1 51c¿

1 1kO

Mlscellaneous
Automotive wire, crimp connectors,
neutral-cure silicone sealant.
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in Fig.B. In fact, the following assembly
procedure assumes that you are build-
ing the "Extra Features" version.

Start by installing the diodes, tak-
ing care to orient each one correctly,
The resistors can then go in - their
values can be checked against the ac-
companying table and with a digital
multimeter,

Next, install the thermistor, the
smaller capacitors and the 1OpF elec-
trolytic, making sure it is oriented cor-
rectly. The discharge capacitor(sJ can
then be installed, As noted above, we
have provided for two capacitors and
also for two different lead spacing on
the PC board.

The SCR is mounted horizontally
with its leads bent down by 90o so
that they pass through their holes in
the PC board. Secure its tab using an
M3 x 10mm screw and M3 nut before
soldering the leads,

The wiring from the PC board to
the generator coil, kill switch and to
the ignition coil must all be rated at
250VAC and 7.54. Automotive wire
should be suitable or you can use
24OVAC mains wire salvaged from a
mains extension cord. The wiring for
the chassis connection should also be
rated at 7.5,{ or more.

By contrast, the trigger lead does not
have to be heavy duty but should have
suitable insulation for automotive use.
Sheath the wires in some flexible tub-
ing to prevent possible chaffing ofthe
wiring insulation. Better still, you may
be able to use the existing wiring for
the original CDI module.

If you want the best spark possible,
you can try adding a second 1pF ca-
pacitor in parallel with the first, This
may improve the "fatness" (intensity)
of the spark. In some cases though,
a 1¡rF capacitance will give the best
spark because 2pF may load the gen-
erator coil too much and lower the
charge voltage,

Once the board is complete, run
the external connections and test the
CDI for correct operation, Adjust the
ignition timing according to the manu-
facturer's instructions.

Potting the circuit
As previously indicated, we used

a potting box (Jaycar Cat, HB-s204)
to house the CDI unit, Potting allows
the components to be protected from
vibration, water ald dust. You must
use a "neutral-cure" silicone sealant
for this job.

Do not use an "acid-cure" silicone,

as this will corrode the wires and cop-
per pattern on the PC board.

Note that the capacitor(s) will pro-
trude a little from the top of the potting
box. The box can be mounted on the
engine frame using suitable brackets.
It should be placed away from the
exhaust side of the engine.

Make sure that any mounting screws
for the box do not penetrate and make
contact with the circuit.

Testing the generator coil
Sometimes the generator coil can

fail due to either a shorted turn or a
broken wire, You can test for a break
in the coil by measuring its resistance

- ie, between its output and ground,
If the coil is OK, its resistance will
probably be less than 200Q,

A shorted turn is not easily checked
except using a special shorted turns

'BASIC' CDI VERSION

Fig.7r follow this parts layout diagram to build the
"Basic Version" of the CDI Module. It can be used for
non-critical applications.

'EXÍRA FEAruRES' CDI VERSION

Fig.8: the "Exha Features" version is tìe one that we
recommend you build. Take care with the orientation
of the diodes and the 10¡rF electrolytic capacitor.

used to calculate a new value for R2
from the formula given in the circuit
description.

If the supply rails are couect, switch
off and fit IC1 & IC2 to their respective
sockets. That done, connect a serial
cable between the programmer and
your PC.

Adaptor board assembly
Fig.S shows the parts layout for

the adaptor board. It's a snap to as-
semble - just install the four wire
links, the two IC sockets (watch their
orientation) and the two 20-pin SIL
pin headers.

Note that the pin headers are mount-
ed on the copper side ofthe board, To
install them, push their longer pins
through until they sit flush with the
top of the PC board, then initially
solder just a pin at either end. The
remaining pins can then be soldered,
after which the plastic strips are slid
down the pins until they rest against
the soldered joints.

You are now ready to install the
WinPIC software on your PC.

Software installation
As mentioned above, the software to

use with this programmer is WinPIC,
available from either http://freenet-
homep age. de/dl+yhflwinpicpr.htnl or
from the SucoN Crm website at www.
siliconchip.com.au, Once it has been
downloaded, it's installed by running
the executable frle winpic s etup, exe,

By the way, do not confuse WinPIC
with other software that's available,
such as WinPICB0O. The latter is a
completely different program and it
will NOT work with this program-
mer.

Setting up WinPIC
After installing WinPIC, you should

make sure that it is correctly set up to
work with the programmer. Here's how
to configure WinPIC:
(r) Start WinPIC and click on the "In-
terface" tab (see Fig, );
(2) Ensure "COMB4 programmer for
serial port" is selected from the drop
down menu;
(3) Ensure that the correct COM port
is set;
(a) Check that both ZIF sockets are
empty ald that the programmer is con-
nected to the PC via a serial cable;
(S) Apply power to the programmer
and click on "Initialize!";
(6) In the "Options" tab, select either

siliconchip.com.au

PortTalk or SMPORT (both are faster
than using the Windows API). By con-
trast, if you wish to use a USB-RS232
converter cable, you are probably safer
selecting the "no direct access at all,
only use win ÄPI" option. This will be

slower but wilì ensure that WinPIC ac-
cesses the correct windows drivers in-
stalled for your USB-RS232 converter,
Refer to the section "Using USB-RS232
Converters" in the accompanying
panel for more information.

UdTAUSilSÆGowffi
This dsPlC/PlC Programmer is

designed to work with native
RS-232 serial ports. How-
ever, many computers
today, especially note-
books, do not have a
serial port, as it has been
superseded by USB. 

-(CìE' --,-æ
Although USB-Io-RS232 

-converter cables are available,
not allwillwork correctly with this <;)--n-
programmer. And for those that do S-:;':9ZF-"
work, programming may be consid- \Y--=="<!F=
erably slower compared to working
direct from a serial port.

The reason some converters don't work has to do with the low-level interface
and the implementation of the USB-to-RS232 converter. ln particular, the prob-
lem arises because some USB-to-R5232 converters are impedect emulations
of the serial port.

ln normal use, pin 3 (Tx) of the RS232 serial port is the transmit line, used to
send data at the selected baud rate. Most USB-to-R5232 converters will correctly
emulate this, as it is necessary for full duplex data transmission.

However, COM84 style programmers like this one use pin 3 (Tx) of the serial
port for the programming voltage and hence as a simple digital output. This is an
unconventional use of the Tx line. lt is accomplished in the WinPlC software by
setting the "break" flag in the line control register (bit 6). However, some USBìo-
RS232 converters (and their supplied software driver) do not emulate the break
flag functionality and therefore will not work with this programmer.

USB-to-RS232 converters based on the newer FTDI chips, especially the
FT232R, could possibly work, given that the specifications claim that the FT232R
has inbuilt support for line break. lt is, of course, up to the manufacturer of the
USB-Io-RS232 converter as to whether the full features of the interface lCs are
supported through the supplied software driver.

lf you would like to try a USB-to-RS232 converter with this programmer, you

should make sure that it supports line break and that the "no direct access at
all, only use Win APl" option is selected in the "Options" tab of WinPlC. This
means that WinPlC will not access the serial ports directly but only through the
Windows APl.

This ensures that WinPlC talks to the windows driver for your USB-to-RS232
converter, rather than trying to access ports that are not implemented. As indi-
cated above, this may result in substantially slower operation than with a native
serial port.

ln ourcase, we tested the Prolific GUC-ADg USB-RS232 converteron Windows
XP and it worked. The only drawback was that it was slow - up to 1 0 times slower
than when running the programmer direct from a serial port.

This is related to latencies in the windows API and the windows driver for the
converter. A small delay (in the order of milliseconds) occurs when switching any
control line and these small delays all add up to a considerable delay due to the
huge number of switching requests made by WinPlC.

Note: the Prolific GUC-AD9 USB-RS232 converter is available from Jaycar
(Cat. XC4834).

ffibæWefltbnGodæ
Value ¡rF Value IEC Code EIA Code

l trF l trF 1u0 105

470nF 0.47¡tF 470n 474

100nF 0.1pF 100n 104

10nF .01¡rF 10n 103

ffih f s RcsM@[owGodæ
tr No. Value 4-Band Code (1%) 5-Band Code (1%)

tr 2 1MO brown black green brown brown black black yellow brown

tr 1 1kO brown black red brown brown black black brown brown

tr 1 51O green brown black brown green brown black gold brown
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The adaptor board is used for programming 10F & 12F series PICs. As shown
here, it plugs into ZIF SKT? on the dsPICÆIC Programmer board.

AII that remains now is to install the
major hardware items, These include
the 2.5mm DC power socket (CON1),
the RS-232 connector (CON2], tog-
gle switch 51, the 6-pin & 8-pin DIL
pin headers and the two 40-pin ZIF
sockets.

Note that the B-pin header must be
installed but the 6-pin header is nec-
essary only if want to program a PIC
or dsPIC externally and need access

to the +5V GND, MCLR-bar/Vpp, PGC
and PGD lines!

Be sure to install the two large 40-
pin ZIF sockets with the correct orien-
tation, If you will only be programming
a few microcontrollers occasionally,
you can replace these with much
cheaper IC sockets but tlneZIF sockets
make life much easier (and are worth
the extra money in our opinion),

Finally, secure four M3 x 9mm sPac-
ers to the corner positions ofthe board
using M3 x 6mm machine screws,
These are used to support the board
off the bench top during use. If you
like, you can also flt four rubber feet
to these spacers.

The dsPIC/PIC Programmer is now
ready for testing,

Preliminary testing
Before using this new program-

mer, it should be given a thorough
check, Important: do not insert a
microcontroller (PIC or dsPIC) into
any ZIF socket before these tests are
completed.

A 16V DC plugpack should be used
to power the dsPIC/PIC Programmer,
although you can also probably use a
15V DC plugpack (just), Apply power
and you should see the red indicator
LED light. If it doesn't, check the sup-
ply polarity and if that's OK, checkthe
polarity of the LED.

Assuming that the LED lights, the
next step is to check the voltages at
the outputs of the two regulators, You
should measure +5V at the outPut of
REG1 (anything ftom 4.8-5.1V ib nor-
mal), while REG2's output should be
close to 13.6V (13.4-13.8V is OK).

If REG's output is lower than 13.4V
increase the value of the B2O resistor
(eg, to 120Q) to bring it into the 13.4-
13.8V range, Conversely, ifthe output
is higher than 13.8V decrease the
value ofthe 82Ç) resistor.

Alternatively, if REG2's outPut is
outside the designated range, check
the voltage between REG2's OUT &
AD] terminals. This value can then be

tester, However, you cal get some idea
if the coil is delivering suffrcient volt-
age by measuring it with a multimeter
set to read AC volts up to 300V, The
voltage is measured when the engine
is turned over.

Take care if making this measure.
ment, since the generated voltage can
give you an electric shock. DO NOT
touch any of the wiring when turning
the motor over.

Note that the voltage measured
across the generator coil will not be
anywhere near the voltage that it de-
velops when running, That's because
the multimeter does not respond well
to the low-frequency voltage fluc-
tuations that occur when kicking the
engine over. In addition, most multi-
meters do not respond to the peak of
the waveform but to the average of a
sinewave,

In practice, you should get a reading
of about 50V AC from the coil.

Another way of testing the coil volt-
age is to connect the CDI module and
measure the DC voltage between the
cathode of D1 and the chassis while
kicking the motor over, The reading

should at least get to 200V DC if you
can kick the motor over fast enough.

Alternatively, if an oscilloscope is
available, the voltage waveform canbe
measured with the probe set to 1.0:1,

One point we have not mentioned is
the polarity ofthe voltage, The capaci-
tor needs to charge to a positive voltage
before the trigger signal occurs. If the
voltage from the generator coil is nega-
tive before triggering occurs' it will
mean that the CDI module described
here is not suitable for replacing the
module in your engine.

You can check the polarity using a

multimeter set to DC volts - it's just
a matter of checking that the voltage
on SCR1's anode goes positive before
the SCR is triggered and negative after
the trigger,

Thigger coil testing
The trigger coil can be tested in the

same way as the generator coil (ie,

measure the voltage between D3 or
D5's cathode and chassis as the mo-
tor is kicked over), This voltage will
be quite small compared to that from
the generator coil and only occurs

over a short portion of each engine
revolution,

Typically, you might measure a

trigger voltage of less than LV using
a multimeter set to read AC volts,
The trigger coil voltage can also be
observed on an oscilloscope,

Of course, the real test is when it is
used with the CDI module itself, as it
must be able to trigger the SCR' SC

as some colours can be difficult to
decipher.

The three diodes ale next on the
list, Be sure to install them with the
correct polarity, as indicated on the
parts layout diagram (Fig,2). Once
they're in, install the two transistors,
again making sure that they are cor-
rectly oriented.

Don't get the t¡ansistors mixed up.
Ql is aBC337 NPNtransistor, while Q2
is aBC327 PNP type. Check that each
is installed in its correct location,

Now for the capacitors: the ceramic
and monolithic types are not polar-
ised ald can go in either way around.
However, the electrolytic capacitors
are polarised, so be sure to install
them correctly,

The next step is to install IC sockets
for IC1 &ICz. Again, make sure that
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these parts go in the right way around

- ie, notched ends to the right. Note,
however, that these sockets are option-
al, Do not install the ICs at this stage

- that step comes later, after the power
supply has been checked out.

Regulators REG1 & REG2 can now
be mounted. These are both installed
with their metal tabs flat against the
PC board. To do this, first bend their
leads down by 90" about 6mm from
their bodies. That done, fasten each
regulator to the PC board using M3 x
10mm screws and nuts, then solder
their leads.

Do NOT solder the leads before bolt-
ing the devices down, as this could
crack the soldered joints and damage
the PC board as the nuts are tightened.
Make sure also that each device is
installed in its correct location,

This completed CDI module is the "Extra Features" version. The board should be installed in a plastic case,and.potted
you may Ïave to experiment with the number of discharge using neutral-cure silicone sealant to ensure reliability (ie'

capacitórs to get the'best spark - see text. to prãtect against vibration, moisture and dust).

o Learn how engine management systems work

o Build projects to corilrol n¡rous, fuel injection and h¡rbo boost systems

o Switch devices on and off on the bas¡s of signalfrequency, temperahre and voltage

o Build t€st ¡nstruments to check fuel injector duty cycle, fuel mixturcs and brake & temperature

Mail oder pr¡ces: Aust. $422.511(incl. GST & P&Pl; 0uerceas $A26.lHl via aimail. Oder by
phontng (æl gæS 3295 & quot¡ng your credit card number; or iaxthe d_etails to f0219939
2e+g; ol-mail your order w¡th Ghcque or Gredit card details to $ilicon Ghip Publlcations,
P0 Box 139, Gollaroy, t$W 2097.

This CDI module is not intended
for use as a replacement for CDI

units that generate their own high
voltage from an inverter requiring a

12V battery supply.
To replace one of these units,

you could adapt one of our Previous
designs, such as the High EnergY

lgnition (StLtcoN CHIP December
1995 and January 2006) orthe Multi-

Spark CDI (September 1997). Alter-
natively, you could consider using
the Programmable lgnition SYstem

from March, April& MaY 2007.
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